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¢ Elektronske graficke komunikacije

rogramima Publish to Web ili eTransmit priprema fajl projekta (crteza) i pomocne fajlove

za slanje Internetom. Ovaj vid grafickih komunikacija predstavlja efikasan metod

potreban za identifikaciju i sakupljanje pomoc¢nih fajlova i njihovu organizaciju na

razli¢ite nacine. Predstavlja jedan segment danas u svetu razvijenih poslovnih
komunikacija.

& Komunikacije posredstvom alata eTransmit

Program eTransmit priprema fajl projekta (crteza) i pomoc¢ne fajlove za slanje preko elektronske
poste. Ovaj vid grafickih komunikacija predstavlja efikasan metod potreban za identifikaciju i
sakupljanje pomo¢nih fajlova i njihovu organizaciju na razlicite nacine.

[ Referentni pojmovnik: Elektronski prenos podataka

Folder (set of files) — Omotnica (set fajlova). Svi fajlovi se smestaju u odgovarajuc¢u omotnicu.
Nakon toga se moze izvrSiti kompresija, i tako pripremljeni fajlovi slati preko elektronske poste.
U ovom sluc¢aju Password se ne moze Koristiti.

Self-extracting executable (*.exe) — Ovim putem se kreira izvr$ni fajl koji je samoraspakujuci.
Fajl sadrzi tekuce ime crteza originalnog fajla. Memorise se u omotnici koju korisnik imenuje.
Primaocu fajla je omoguceno lako raspakivanje fajla, ako izvrsi dvoklik na odgovarajuc¢u ikonicu.
Ni u ovom sluc¢aju opcija Password se ne moze koristiti.

Zip (*.zip) — Ovom opcijom kreira se *.zip fajl koji sadrzi ureden skup fajlova. Kada korisnik
primi fajl i izvrsi dvoklik na njegovu ikonicu, on se automatski dekomprimuje.

Convert drawings to — Vrsi se zapis fajla koji se $alje u formatu ranijih verziju AM-a.

Preserve directory structure — AM kreira set omotnica koji odgovara omotnici koja se prenosi.
Kada ova opcija nije potvrdena, svi fajlovi se svrstavaju u jednu omotnicu.

Remove patch from Xref and images — Izabrana opcija ovog tipa tekuce putanje za pripadajuce
*.dwg fajlove i slike koje su pridruzene teku¢em crtezu Se brisu.

Send e-mail with transmittal — Izabrano polje znaci da se ono sto se $alje pridruzuje
elektronskoj posti.

Make web page files — Ovom opcijom vrsi se slanje na Web stranu.

¢ Komande za komunikaciju eTransmit
e Meni: etransmit... e Dinamicki unos: etransmit ()
e Komandna linija: etransmit ()
Algoritam: primena eTransmit
Primer: Za otvoren fajl PRIRUBNICA.dwg izvrSiti pripremu crteza za prenosenje

elektronskom postom primenom alata eTransmit. Formirani skup fajlova pripremiti u folderu
GRAF_KOM.
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1. Priprema za postupak pakovanja.

e Otvoriti fajl PRIRUBNICA.dwg (sl. 19.1).

e Podesiti crnu boju radne povrsine, postupcima iz menija: Tools P Options... » Kartica
Display » Colors... » lista Colors: » Black » Apply & Close » OK.
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Sl. 19.1 Deo crteza iz fajla PRIRUBNICA.dwg

2. Postupci pakovanja fajlova.

e Samenija File aktivirati komandu eTransmit.

e U otvorenom dijalogu Create Transmittal (sl. 19.2) kartice Files Tree uneti po potrebi
znacajne informacije u polje Enter notes... U ovom slucaju otkucati poruku:
PRIRUBNICA E-34 KONSTRUISANA ZA POTREBE ROTACIONOG UREDJAJA ER-6.

e Kiliknuti na ek. taster OK ¢ime se otvara dijalog Specify Zip File.

P Create Transmittal =)
e 0 Py Specify Zip File [
5 Cunrert Drawingls) 4 Currert user: Administrator =
Fios Tree | s Table]| Select a transmittal setup Saven: | ). PRIMERI . & @ ¥ B Vews v Took ~
/1S Curent Drawing s g Mame Date modified Type
{3 ¥ PRIRUBNICAdwg e CIPODLOSKA - Standard 12/3/2010 7:57 PM WinZip File
£l
Setup description Y
} b
12
g
Included 1fieis), 137KB [ Add Fie.. | Preview ! -
Enter notes to include wih this transmittal package
PRIRUBNICA E-34 KONSTRUISANA ZA POTREBE Z P
ROTACIONOG UREDJAJA ER-6 \L7 Fierame:  PRIRUBNICA- Standard 2p - R‘
2 L
Files of type: | 2p file ("zip) <[ concal | save
o) et ) [ a) b)

Sl. 19.2 Dijalog Create Transmittal sa aktivnom karticom Files Tree
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e Posredstvom liste Save in odrediti lokaciju gde se memorisu pripremljeni fajlovi. Neka to

bude adresa lokacije fajla D:\GRAFICKE KOMUNIKACIJE\ .\AM11\PRIMERI.

e Prethodna podesavanja mogla su se izvrSiti u dijalogu Create Transmittal na osnovu
otvaranja novih dijaloga posredstvom ek, taster Transmittial Setups i Add File...

e Kada su podesene sve opcije, kliknuti na ek. Save.

3. Pregled formiranih fajlova.

e Ako se otvori dijalog Create Transmittal i aktivira ek. Taster View Report moze se u

novootvorenom dijalogu View Transmittal Report videti nazivi i ekstenzije pripremljenih
fajlova (sl. 19.3).

e Zatvoriti dijalog klikom na ek. taster Close.
e Ovim je sve $to se zeli eksportovati snimljeno na disku i pripremljeno za mreznu

distribuciju.

View Report t

a)

b)

.

ﬂ View Transmittal Report &J

'}% Cument Drawing(s): PRIRUBNICA dwg
—=

Drawing:
This is a transmittal based on PRIRUBMICA dwg.

Fles:

Root Drawing:
PRIRUBNICA.dwg

The following files were excluded from the transmittal:
acad fmp
Fonts'simplex.shoc
Fonts\JSOCP .SHX
Fontstypeshp.shx
Fonts\amgdt shoc
Fonts\TXT.SHX
Fonts | TALIC.5HX

m

Conversion:
Ay drawing files from AutaCAD R12/LTS7/LT58 or eadier will be converted to AutoCAD
2010/LT 2010 format in order to remove xref and image paths.

Motes for distribution:

The AuteCAD variable FONTALT was set to:

C:\Users' Administrator\appdata“roamingautodesk \autocad mechanical 2010 18.04enu
"supportsimplex shx

Please make sure that the FONTALT variable is set to this file or an equivalent before

opening any drawings. Al text styles with missing fonts are automatically st to this font. -

Savehn. |

\y

Sl. 19.3 Dijalog View Transmittal Report za pregled fajlova za eksport

¢ Kreiranje i objavljivanje WEB dokumenata

Pomoc¢u komande Publish to Web, korisnik CAD programa AM svoje crteze konvertuje i postavlja
na odgovaraju¢u Web lokaciju. Primenom jednostavnih postupaka generisu se HTML stranice u
kojima se crtezi formiraju u vektorski *.dwf, ili rasterske formate tipa *.jpeg ili *.pnr. Pri tome nije
neophodno znanje iz HTML programiranja [20]. Osnovni i pomo¢ni fajlovi postavljaju se direktno
na Internet ili na lokalni odnosno mrezni disk. Ovim postupcima omogucuje se, takode, 1 brzo

azuriranje ranije formiranih Web dokumenata na Internetu ili na intranetu lokalnog sistema.

Poglavlje 19
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LA Referentni pojmovnik: Web dokument

Name and DWF image — Kreira Web stranicu i umece crtez formata *.dwf. Fajlovi ovog tipa
(Drawing Web Format) se kreiraju kao male elektronske kopije fajlova crteza (*.dwg, *.dwt), koje
daju slike visokog kvaliteta i koje su posebno namenjene za brzo prikazivanje na Internetu. DWF
fajlovi se mogu prikazato u pretrazivacu Web-a. Programa Volo View Express koji se moze
preuzeti sa Autodesk-ove Web lokacije www.autodesk.com ili sa namenskog CD—a.

Medium JPEG and thumbnail — Kreira Web stranicu prikazujuéi crteze kao niz minijaturnih
slika za prethodni pregled i formira raster sliku svakog crteza u formatu jpeg (jpg), takode,
srednje veli¢ine i niZe rezolucije.

Large JPEG and thumbnail — Formira Web stranicu prikazujuci crteze kao niz minijaturnih
slika za prethodni pregled i kreira sliku crteza u formatu *.jpg, srednje veli¢ine i visoke rezolucije.
I-drop — Ova opcija omogucuje korisniku da crteze koji su objavljeni na Web-u prevuce u
sopstveni (teku¢i) crtez. Poseban ¢ita¢ umece crteze kao blokove u tekuci crtez. Alat i-drop
omogucuje da se crtezi jednostavno distribuciju drugim ¢lanovima projektnog tima kada korisnik
svoju Web stranicu objavljuje na Internetu ili intranetu.

DXF — Poseban format fajla koji je postao sinonim za format *.dwg. Ovi formati su prakti¢no
izjednaceni po vaznosti. DXFx je Poseban format fajla koji je kompatibilan sa novijim
operativnim sistemom Windows. Ovaj format je podesan za prikazivanje crteza Autodesk Design
Review Viewer-a.

¢ Opcione komande: kreiranje Web dokumenta

e Meni: File » Publish to Web... e Dinamicki unos: publishtoweb ().
e Komandna linija: publishtoweb (J)

Algoritam za kreiranje Web dokumenta

Primer: Za AM fajl CRTEZl.dwg (iz omotnice PRIMERI) Kkoji sadrzi osam crteza 2D
masinskih delova, formirati Web dokument na osnovu komande Publish to Web.

4. Priprema za Web podrsku konstruisanju.

e Otvoriti fajl VRATILO2.dwg sa omotnice PRIMERI (sl. 19.4).
e Izvrsiti pregled svih Layout-a ovog fajla, a zatim se vratiti u prostor modela.

163 a0
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0,02 | 4B
13, 76 hazz 1LI0Gz o
20,
R ¢ —= Ra 08
7 0,025 |AB]
Radd | Fa Fia .ty Fadd E_,/i B o PZ5[AE]
=| ¢ = = &‘l | Re B
o = = =) = + = o o =
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g2 : & = = & | = = £ =| |2 I §
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Sl. 19.4 Jedan crtez iz fajla VRATILO2.dwg
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5. Primena postupaka Web konstruisanja.

e Sa menija File aktivirati komandu Publish to Web.
e U novootvorenom dijalogu Publish to Web (sl. 19.5), izabrati opciju ® Create New Web
Page, a zatim pritisnuti ek. taster Next >.

Publish to Web - Begin

» Begin
Create Web Page

Select Image Type
Select Template
Apply Theme
Enable i-drop
Select Drawings
Generate Images
Preview and Post

This wizard creates a Web page that displays images from
one or more drawing files. You can control the appearance
of your Web page by choosing from a variety of templates.

Once you have created a Web page, you can use this
Wizard to update it

(@ Create New Web Page
() Edit Existing Web Page

< Back [ Next>,}J[ Cancel
L2\

A

Sl. 19.5 Dijalog za kreiranje Web-a Publish to Web - Begin

e U slede¢em dijalogu u polju za tekst Specify the name of your Web page uneti naziv

WEB CRTEZI (sl. 19.6).

e Posredstvom ek. tastera Browse (...) moze se definisati nova adresa i folder budu¢e Web
stranice, kao npr. DNAM\WEB CRTEZI. Podrazumevana adresa je ona koja je definisana
kao C:\Users\Administrator\ ... \Autodesk\WEB CRTEZI.

e U donjem polju Provide a Description to appear on your Web page. uneti opis

Dvodimenzionalni modeli.

e Po zavrsetku unosa kliknuti na ek. taster Next >.

“
Publish to Web - Create Web Page @
) Your Web page and its corfiguration file are stored in a
Begin directory in your file system to enable future editing and
¥ Create Web Page posting. The name of this directory is the same as the name
of your Web page. You can choose the location (parent
directory) where this folder is created.
o ggn:ﬁgot:f name of your Web page (do not include a file
Select Template ;
Apply Theme WEB CRTEZI
Enable i-drop . . . .
Specify the parent directory in your file system where the
Select Drawings Web page folder will be created.
Generate Images C:\Users\Admiristr...odesk \WEB CRTEZI =
Preview and Post
Provide a description to appear on your Web page.
Dvodimenzionalni modeli
[ <Bsck |[ Ned>n] [ Cancel
L2\

Sl. 19.6 Dijalog za kreiranje Publish to Web - Create Web Page
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U slede¢em dijalogu Publish to Web - Select Image Type izabrati vektorski DWF format

fajla (sl. 19.7).

Ostale opcije ostaju podrazumevane.

Pritisnuti ek. taster Next >.

r

Publish to Web - Select Image Type

(S5

Begin
Create Web Page

» Select Image Type
Select Template
Apply Theme
Enable i-drop
Select Drawings
Generate Images
Preview and Post

Select an image type from the list below.

Image size: Small

DWFx
JPEG ectorbased representation of AutoCAD
PNG Fx files can be viewed with Intemet

h the free Autodesk Design Review viewer.

LUsing Autodesk Design Review, you can zoom and pan
within the DWFx file, tum layers on and off, add markups,
and activate named views.

DWFx files are inserted into your completed Web page in a
size that is optimized to display well with most browser
settings.

[ <Back || Next>N[ Cancel

Sl. 19.7 Dijalog za kreiranje slike Publish to Web - Select Image Type

Sl. 19.8 Dijalog za izbor uzornog fajla prikaza crteza Publish to Web - Select Template

U slede¢em dijalogu Publish to Web - Select Template izabrati nacin prikaza, odnosno
redosled Array plus Summary (sl. 19.8).

Pritisnuti ek. taster Next >.

Publish to Web - Select Template

Begin
Create Web Page

Select Image Type
» Select Template
Apply Theme
Enable i-drop
Select Drawings
Generate Images
Preview and Post

Select a template from the list below. The Preview pane
demonstrates how the selected template will affect the layout
of drawing images in your Web page.

Web Page Title

of Thumbnails
List-of Dirawings -
1 2 3.

Summary Infarmation

Creates a Web page containing an amay of thumbnail images
and summary information about the image the mouse is
cumently hovering over. The summary information includes
values from the Summary tab of the Drawing Properties dialog
box (accessed using the DWGPROPS command).

[ <Back || Neﬁ>%[ Cancel |

U narednom dijalogu Publish to Web - Apply Theme izabrati iz liste prikaz tipa Classic.



8-19 AutoCAD Mechanical 2011 Poglavlje 19

e Pritisnuti ek. taster Next >.

-

Publish to Web - Apply Theme S5
. Themes are preset elements that control the appearance

Begin of various elements [such as fonts and colors] of your

Create Web Page completed Web page. Select a theme from the list below
to apply to your Web page.

Select Image Type Autumn Fields
Classic

Select Template Cloudy Sky k

» Apply Theme Dusky Maize
Enable i-drop QOcean Waves
Select Drawings Rainy Day

Supper Club
Generate Images

Preview and Post Label: Drawing 1
Description: Drawing 1

Summary Info: Field 1

[ <Back | Nm>§[ Cancel

Sl. 19.9 Dijalog za kreiranje prikaza Publish to Web - Apply Theme

e U slede¢em dijalogu Publish to Web - Enable i-drop (sl. 19.10) izabrati [7] Enable i-drop
za omogucavanje kopiranja originalnog fajla *.dwg formata.
e Pritisnuti ek. taster Next >.

-

Publish to Web - Enable i-drop =5
Begin If desired, you can create an i-drop(R) enabled Web page
Create Web Page that posts copies of your DWIG files along with the images

that you generate. Using i-drop, those who visit your Web
page can drag-and-drop drawing files into a session of
AutoCAD. i-drop Web pages are ideally suited to publishing
block libraries to the Intemet.
Select Image Type
Select Template

Apply Theme
» Enable i-drop
Select Drawings

Enable i-drop

Generate Images
Preview and Post

<Back | Nen>,\ej [ cancel
I/\v

Sl. 19.10 Dijalog Publish to Web - Enable i-drop

e U dijalogu Publish to Web - Select Drawings izabrati crtez vratila sa detaljima i tabelom
koji su kreirani u prostoru modela (sl. 19.11).

e Nakon izbora izvrsiti dodavanje u Image list-i ek. tasterom Add ->.

e Pritisnuti ek. taster Next >.
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- ~
Publish to Web - Select Drawings [éj
) To add an image to your Web page. select a drawing and then pick one of its layouts.
Begin Enter a label and description to annotate the image on the Web page. then choose Add.

Create Web Page To change an image, select it in Image List, specify new settings then choose Update.
An asterisk indicates a missing drawing.

Image settings Image list

Select Image Typs  Draning: Miz |
Select Template [CATUTORM.. ATILO2dwg  ~| [ ]

Update ->
e —
Enable i-drop [Modal v] Remove

» Select Drawings A3 PRIPREMA
Generate Images A3_RADIONICK]
Preview and Post Model k
Description:
e Ul

[ <Back | Neﬁ>¥[ Cancel

Sl. 19.11 Dijalog za selekciju crteza Publish to Web - Select Drawings

e U narednom dijalogu Publish to Web - Generate Images oznaciti ® Regenerate alll
images za omogucavanje prikaza svih slika definisanih formata (sl. 19.12).
e Pritisnuti ek. taster Next >.

. 5
Publish to Web - Generate Images [éj
Begin Choose Next to generate your Web page. The Web page
is created in the file system directory that you specified
e s earlier in this wizard. You cannot undo this operation once it
is started.

You will have the opportunity to preview the Web page and

Select Image Type post it to the Intemet in the following step.

Select Template

Ppply Theme Please wait while the images are generated.
Enable i-drop
Select Drawings
» Generste Images () Regenerate images for drawings that have changed

HEnenEls @ Regenerate allimages

<Back | Next>’}J[ Cancel
I/\v

Sl. 19.12 Dijalog Publish to Web - Generate Images

e U dijalogu Publish to Web - Preview and Post (sl. 19.13) izvrsiti prelimimarni pregled
novonastale Web stranice.

Postupak formiranja Web crteza je primenjen za prethodni crtez, usvajajuci
umesto dwf, jpeg format. Adresa gde su formirani crtezi je, takode, razlicita i nalazi se na folderu
D:\AM11\GRAFICKE KOMUNIKACIJE\WEB gde je i folder ETRANSMIT.
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-

Publish to Web - Preview and Post

S

Begin
Create Web Page

Select Image Type
Select Template
Apply Theme
Enable i-drop
Select Drawings
Generate Images
» Preview and Post

Your finished Web page has been successfully created in the
following directory:

C:\Users\Administrator' App Data“\Roaming Autodesk \WEB
CRTEZI

You can postgur Web page to the Intemet on your own by

copying all files in this directory to @ Web site at a later time.

Oryou can post your Web page now.

After posting your Web page, you can create and send an

email message that includes a hyperinked URL to its
location.

Send Emai

o
@

Can

Sl. 19.13 Dijalog za prethodni prikaz crteza Publish to Web - Preview and Post

e U prozoru Web Publishing — Microsoft Internet Explorer (sl. 19.14) moze se videti
formirana stranica dokumenta HTM formata. Ostali fajlovi nalaze se u folderu WEB
CRTEZI.

e Pritisnuti el. taster Finish, ¢ime se kona¢no zavrSava proces generisanja Web dokumenta.

& C\Users\Administrator\AppData\Roaming'Autodesk\WEB CRTEZIMLhtm - Windows Internet Explorer =
@ U' |§‘ C\Users\Administrator\AppData\Roaming\Autodesk\ WEB CRTEZINMI htm v| +y | A ‘ | Bing R -
File Edit View Favorites Tools Help x '%3 4

Do Favorites =3
. »
& C\Users\Administrator\AppData\Roamin... ’:?" Home = 5] = [ =] Read Mail [} Print  » Page~ Safety v Tools~ ':Q-' Help ~
Markup & Measure  Tools = - i
Mode! Ji @A EE | e @ - 1of 1
143
az1] i &72
| ow ol ¢ = N A
Pyt |t ] »;f‘i mgh Jug [ W b m 7
] b (17
. o | e 1 12
A5 B3k it E = i
[T
- 52
/T3 [T T - » T Lo 1
. 1 m ! 16
L - 3 [ D=
n b i 1l 11 I
sk
betalj E Bl CE1 oy b B EA
28 Materlfal: € 4732,
Dimenzijz materijals #F4abl,
AP aMENA; P obeljsati na Rm= 561 do 910 K/ mime, .
ni
Done € Internet | Protected Mode: Off fa v ®50% -
\

Sl. 19.14 Izgled generisanog IM1.htm Web dokumenta
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e U prozoru Plot and Publish Details (sl. 19.15) moze se videti kreirana stranica tekstualnog

formata o adresi fajla.

e Ovaj dijalog se moze inicirati na osnovu komande u statusnoj liniji AM interfejsa kada se
aktivira ek. taster Plot/Publish Details Report Available: No New Errors or Warnings.

A plot and Publish Details

Plot/Publish Details Report Available: No New Errors or Warnings

a) b)

Sl. 19.15 Izgled generisanog dokumenta

& Generisanje tehni¢kih dokumenata

\l'iEw:|N| '| |r|'50:pytu Clipboard

[=] 30b: - Plotted

Job ID: 4

Sheet set name;

Date and time started: 12/4/2010 10:28:59 AM
Date and time completed: 12/4/2010 10:28:59 AM
UserID: Administrator

Profile ID: <<ACADMPP>>

Total sheets: 1

Sheets plotted: 1

Number of errors: 0

Number of warnings: 0

/[=] Sheet: - Plotted

File: C:\TUTORIJAL Z& GRAFICKO MODELIRANIE 1
VIZUELIZACIIUN\LOGISTIKA\AMECH\PRIMERI\WRATILOZ.dwg

Category name:

Page setup:

Device name: PublishToWeb IPG.pc3 - plotted to file

Plot file path: C:\Users\Administrator\AppData‘\Roaming\Autodesk\WEB
CRTEZI\IM1a.jpg

Paper size: User 1 (123.00 x 95.00 Pixels)

m

v

Pre Stampanja formata crteza mora se uspostaviti komunikacija izmedu AM-a i plotera. Ovaj
postupak se naziva konfiguracijom uredaja za Stampanje. Iz liste plotera je potrebno izabrati
odgovarajuci uredaj. Ovaj ploter postaje deo baze podataka softvera, tako da se moze Koristiti

viSe puta.

L Referentni pojmovnik: Konfiguracije plotera

My computer — Opcija konfiguracije plotera za kompjuterom Kkoji se trenutno Kkoristi.
Network plotter server — Konfiguracije plotera pomo¢u mreZznog Servera.

System plotter — Konfiguracija sistemskog plotera.

Edit plotter configuration — Opcija kojom se vrSe izmene ranije unetih parametara

konfiguracije.

Calibrate plotter — Opcija kojom se moze vrsiti Kalibrisanje i testiranje plotera.

¢ Komande za konfigurisanje plotera

Meni: File » Plotter Manager...
Komandna linija: plotmanage
Dinamicki unos: plotmanage
Ribon: Output » Plotter Manager
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Algoritam: postupak konfigurisanja plotera i Stampanje crteza

Primer: Izvrsiti konfiguraciju Stampaca HP (Hewlett-Packard) za potrebe generisanja
tehnickog dokumenta - radionickog crteza Vratilo-02. Crtez pripremiti za Stampanje na A3

formatu.

1. Iniciranje konfiguracije Stampaca.

e Izvrsiti izbor opcije Plotter Manager... (sl. 19.16a) iz padajuce liste menija File.

e Nasl. 19.15b prikazani su unapred konfigurisani ploteri. Osim DWF uredaja koji
dozvoljava pregled crteza putem Interneta, ploter jos nije konfigurisan.

e Izvrsite dvoklik na ikonicu Add-A-Plotter Wizard, ¢ime se inicira konfiguracija.

New Sheet Set...

Ctrl+N

(571 Mew Inventor Link...
& Open...

Open from Vault...
Open Sheet Set...
Load Markup Set...

g

| i Wiyl

Ctrl+0

&

Close

Partial Load
Import...

Save Ctrl+S
Save As...
eTransmit...
Publish to Web...
Export 4

DHBHODTD H

Vault »

Page Setup Manager...

Plotter Manager...

Plot Style Manager... %

Plot Preview

Plot... Ctrl+P
Publish...

View Plot and Publish Details...

peicgen gt el ffc alfa

a)

Drawing Utilities 3

Ctrl+Shift+5 }

= Libraries
3 Documents
rJ:‘ Music
[=| Pictures

B videos

& Homegroup

9 items

= [ B e |
ol [1) « enu » Plott.. » - |&,|| Search Plotters r
Organize v Include in library = » H~ 1 @
~

i Favorites . Plot Styles

B Desktop PMP Files

& Downloads 2] Add-[RPLnﬁerWizard

"Ll Recent Places @Defau indo: tern Printer

vJ Location: addplwiz (C:\Program Files\Autodesk\ ACADM 2010)
D

@DWFX ePlot (XPS Compatible)
i3 DWG To PDF

i PublishToWeb JPG

i) PublishToWeb PNG

Sl. 19.16 Postupak iniciranja dijaloga Plotter Manager...

2. Postupak konfigurisanja stampaca.

e Prethodnim postupkom se
otvara prvi dijalog Add Plotter

- Introduction Page (sl. 19.17).

e Klikom na Next > informacija
0 konfiguraciji bice sacuvana
u fajlu sa ekstenzijom *.pc3.

Sl. 19.17 Dijalog Add Plotter -
Introduction Page

b)

.
Add Plotter - Introduction Page

This wizard provides you with the ability to corfigure either an existing Windows
system plotter, or a new non-Windows system plotter. The corfiguration information
will be saved in a PC3file. The PC3 file will be added as a plotter icon that can be
selected from the Autodesk Plotter Manager

You can choose to import corfiguration information from @ PCP or PC2 file, then add
that information to the new plotter configuration file you are creating.
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e Prethodnim postupkom se otvara sledeci dijalog Add Plotter - Begin (sl. 19.18).

e U dijalogu odabrati opciju ® My Computer i kliknuti na Next >.

7
Add Plotter - Begin

pEBegin

Flotter Model

Impart Pep or Pc2
Ports

Plotter Name
Finish

To configure a new plotter, select one of the following:

@) My Computer
All settings will be configured by an Autodesk Heidi plotter
driver, and managed by this computer.

() Network Plotter Server

() System Printer

<Back | Next>,}_][ Cancel
b\\)

Sl. 19.18 Pocetni dijalog Add Plotter - Begin

Ovim se otvara slede¢i dijalog Add Plotter - Plotter Model (sl. 19.19).
U polju Manufacturers izabrati uredaj Hewlett-Packard.

U listi Models izabrati ploter DesignJet 750C C3196A.

Posle selekcije kliknuti na Next >.

- "
Add Plotter - Plotter Model [

Begin

p=FPlotter Model

Import Pep or Pc2

Select your plotter manufacturer and medel.  your plotter isnt listed, consult your
D plotter documentation for a compatible plotter.

Optionally, f you have an installation disk containing an HD| driver, choose Have
Disk. A Browse for HIF File dialog box is displayed for you to locate and install the
HIF file attached to the HDI driver.

Ports
;I:i:ir JEE Manufacturers Models
Autodesk ePlot (DWFx) . | | DesignJet 700 C47058 -
Autodesk ePlat (PDF) DesignJet 700 C47068
CalComp M| [esign.et 750C C3195A 7
Hewlett-Packard |=| DesignJet 750C C3196A =
Raster File Formats : E)esignJ_et ZE}[_)(_: f!us Cdz@_ﬂ? -
Yerox e om. 2
This model i rted by HPGL/2 - by Autodesk
is model is supported by by Autodes!
<Back || MNex >,}J [ Cancel |
L2\

Sl. 19.19 Dijalog Add Plotter - Plotter Model

e Prethodnim postupkom se otvara sledeci dijalog Add Plotter - Import Pcp or Pc2

(sl. 19.20).

e Uvoz fajlova za kontrolu pera za stampanje omogucen je ovim fajlovima, te se opcijom
Import File... oni mogu uvesti u formatu *.pc3.
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e Ako se ne zele Koristiti ovi fajlovi u AM-u Kliknuti na el. taster Next >.

Add Plotter - Import Pcp or Pc2 @
Begin To import plotter specific information from a previously saved
PCP or PC2file, choose Import File. Paper size, plot
optimization level, network share names, and port names can
be imported into the new PC3file.
Flotter Model
plmport Pcp or Pc2
Plotter Name
Finish X .
MOTE: Use the Add Flot Style Table wizard to import pen
assignment information. Use the Import PCP/PC2 Settings
wizard to import PCP or PC2 page setup information.
[ <Back || Nex >,\€] [ cancsl
I}
. \

Sl. 19.20 Dijalog Add Plotter - Import Pcp or Pc2

e Prethodnim postupkom se otvara sledeci dijalog Add Plotter - Ports (sl. 19.21).

e |zabrati port LPT2 Kkoji ¢e se Kkoristiti za komunikaciju izmedu kompjutera i stampaca za
Stampanje tehni¢ke dokumentacije.

e Kiliknuti na el. taster Next >.

r 5
Add Plotter - Ports ==
Begin @ Plottoapot () Plot to File () AutoSpool
The following is a list of all ports available for the cumenthy
corfigured device. All documents will be plotted to the port
Flotter Model you select.
Import Pep or Pc2 Port Description Printer o=
p-Ports LPT1 Local Port
FEETEE LPT2 Local Part A
FoEn LPT3 Local Port |E |
XPSPort Local Port Microsoft XPS... [
Microsoft X... Network Port
L | Y- Ar Dot o
[ Configure Port ... ] [ What is AutoSpoaol... ]
[ Show all system ports and disable 10 port validation
<Back [ Nex >,\Q [ Cancel
12
% A\

Sl. 19.21 Dijalog Add Plotter - Ports

e Ovim se otvara slede¢i dijalog Add Plotter - Plotter Name (sl. 19.22).
e U polju Ploter Name: moze Se izvrsiti izmena naziva Stampaca.

e Pod pretpostavkom da se originalno ime zadrzava, kliknuti na el. taster Next >.
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Add Plotter - Plotter Name @

Begin The model name you selected is the default plotter
configuration name. You can accept the default name, or
enter a new name to identify the new PC3file you have
created. The name you apply will be displayed in the Page

Plotter Model Setup and Plot dialog boxes.
Import Pcp or Pc2
Ports Plotter Name:

pFlotter Name DesignJet 750C C3195A
Finish

Mote: If you enter a name that is exactly the same as a System
Printer’s name, you will not see the System Printer listed in the
AutoCAD Mechanical 2010 Plot or Page Setup dialog boxes.

<Back | Next>r\;[ Cancel
X

)

Sl. 19.22 Dijalog Add Plotter - Plotter Name

e Prethodnim postupkom se otvara poslednji dijalog Add Plotter — Finish (sl. 19.23).
e Ek. tasterom < Back moze se izvrsiti povratak na prethodne postupke konfigurisanja.
e Ako se ni uredivanje ni testiranje ne vrsi, kliknuti na el. taster Finish.

Add Plotter - Finish ==

Begin The plotter DesignJet 750C C3195A has been installed with its
default corfiguration settings. To modify the default settings,
choose Edit Plotter Configuration.

Plotter Model

Import Pcp or Pc2

Ports

Plotter Name [ Edit Plotter Corfiguration ... |
mFinish

Optionally, to perform a plot calibration test on the newly
configured plotter, and verify that your drawing measurements
plot accurately, choose Calibrate Plotter.

[ Calibrate Plotter ...

<Back || Finish ,\ej[ Cancel
b\\)

Sl. 19.23 Dijalog Add Plotter - Finish

3. Priprema za stampanje crteza iz prostora papira.

e Otvoriti fajl VRATILO.dwg iz foldera PRIMERI.

e Kiliknuti na karticu A3_RADIONICKI gde se pripremljen crtez nalazi u prostoru papira
(sl. 19.24).

e Crtez je sastavljen od uokvirenih sest viewport-ova, ili tzv. vizira koji se dobijaju na
osnovu komande makeview (otkucati u komandnoj liniji MV i potvrditi Enter-om).

e Jedan od vizira postaje aktivan, ako se izvrsi dvoklik na njegovu povrsinu. Time je on
vizuelno prepoznatljiv po podebljanom okviru (isti crtez).
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7 i
M1 Plot - Model e
@ Learn about Plotting
Page setup
Mame: [<None> '] [ Add... ]
Printer fplotter
Mame: [@ Microsoft XPS Document Wrter V] [ Properties... ]
Plotter: Microsoft XPS Document Writer - kg5 —
Where: ¥PSPort: T
Description: 'é.:
[T Plot to file l
Paper size Mumber of copies
[Letter "'l 1 :
Plot area Plot scale
What to plot: Fit to paper
D
Scale: | Custom
Plot offset (origin set to printable area) 1 =
y; 0.000000  inch [T] center the plot 11.41
y: 0.000000 inch Scale lineweights
Apply to Layout [ oK ] [ Cancel ] [ Help ] @

Sl. 19.24 Dijalog Plot - Model sa osnovnim opcijama za izbor stampaca Printer/plotter i formata
crteza Paper size

e Razmera sadrzaja vizira omogucena je komandom Zoom ili na osnovi alata palete
Viewports (sl. 19.26). Podesavanje razmere se moze vrsiti nezavisno, od vizira do vizira.

e OKkvir vizira se nalazi u sloju AM_view.

e |z liste slojeva pre stampanja iskljuciti sloj AM_view.

e Okuviri zaglavlje A3 formata za radionicki crtez dobija se insertovanjem, postupcima
Insert Block, gde se putem dijaloga vrsi unosenje sadrzaja fajla SRB A3_delovi.dwg
(iz foldera FORMATI).

4. Postupci Stampanja crteza.

e Aktivirati komandu Plot... iz menija File, ¢ime se otvara dijalog Plot - Model.

e |z liste Printer/plotter izabrati konfigurisani stampa¢ DesignJet 750C C3195A.pc3
(sl. 19.25).

e Ostale parametre podesiti prema istoj slici.

e |z liste Paper size izabrati format papira za Stampanje 1ISO A3 (420.00x297.00 MM).

e Ostale parametre podesiti kao na slici.
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i
P19 Plot - Model

==

(i) Learn about Plotting

[Iso A3 (420.00 x 297,00 MM)

7

Plot area

What to plot:

Plot offset (origin set to printable area)

Plot scale

Fit to paper

Scale: | Custom

1

Page setup Plot style table (pen assignments)
MName: [<None> V] ’ Add. ] [None
Printer plotter Shaded wiewport options
Mame: [f!i DesignJet 750C C3155A.pc3 V] ’ Properties. .. ] Shade plot Ac displayed -
Plotter:  Designlet 750C C3195A - HPGL/2 - by Autodesk Quality
k—s20 wH—4 ]
Where: LPT2 n B 150
Description: ~
E1 Flot options
[CIPlot to fie T [“IPlot in background
Prreaes A Plot object lineweights

1 r Plot with plot styles
- Flot paperspace last
Hide paperspace objects
[ Plot stamp on

[T save changes to layout

Drawing crientation

-]

& Canon LEP2300

i Default Windows System Printer.pe3
& DWFE ePlot pc3

B DWFx eFlot (XPS Compatible) pc3
{8 DWG To PDFpc3

& Publish ToWeb JPG pc3

 Publish ToWeb PNG.pc3

m

1

: 0.00 mm [T| center the plot e ot () Portrait
(@ Landscape
y: 0.00 mm Scale lineweights [ Plot upside-down
[ Apply to Layout ] [ Ok ] [ Cancel ] [ Help
IS0 A3 (420.00 x 297.00 MM)
IS0 expand A2 (594,00 x 420,00 MM)
IS0 expand A2 (420.00 x 534.00 MM)
DesignJet 750C C3135A.pc2 IS0 AZ (554.00 x 420.00 MM)
B h IS0 A2 (420,00 x 594.00 MM)
= Nons _ - 150 expand A3 (420.00 x 297.00 MM)
& Microsoft XPS Document Wiriter 150 exi and A3 izgzr'.no x 420.00 MMi
& Fax IS0 A3 (420,00 x 297.00 MM

ISO A3 (297.00 x 420.00 MM)

150 expand A4 (2597.00 x 210.00 MM)
IS0 expand A4 (210,00 x 297.00 MM)
ISO A4 (297.00 x 210.00 MM)

IS0 A4 (210.00 x 297.00 MM)

ARCH expand D {24.00 x 36,00 Inches)
ARCH D (24.00 x 36.00 Inches)

ARCH expand C (24.00 x 18,00 Inches)
ARCH expand C (18,00 x 24.00 Inches)
ARCH C (24.00 x 18.00 Inches)

ARCH C {18.00 x 24,00 Inches)

AMSI expand D (22.00 x 34.00 Inches)
ANSI D (22.00 x 34.00 Inches)

ANSI expand C (22,00 x 17,00 Inches)
AMSI expand C (17.00 x 22,00 Inches)
ANSI C (22.00 x 17.00 Inches)

AMSI C {17.00 % 22,00 Inches)

AMSI expand B (17.00 x 11.00 Inches)
ANSI expand B (11.00 x 17.00 Inches)
AMSL B (17.00 x 1100 Inches)

ANSIB (11.00 x 17.00 Inches)

ANSI expand A (11.00 x 8.50 Inches)
ANSI expand A (8,50 x 11,00 Inches)

Sl. 19.25 Prosireni dijalog Plot - Model sa odgovaraju¢im opcijama

e Opcijom Preview... izvrsiti pregled veli¢ine stranice i ceo crtez koji se Stampa, ukljucujuci

i okvir crteza.

e Klikom na ek. taster OK pocinje Stampanje crteza koji kada se odstampa ima izgled kao

nasl. 19.26.
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7~ Kontrolna pitanja za Poglavlje 18:
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Funkcija i podela mehanizama.

Bregasti mehanizmi.

Komande AutoCAD Mechanical-a za proracun i konstruisanje mehanizama.
Proracun kinematskih i dinamickih karakteristika jednog mehanizma.
Dijalog Cam Design and Calculation.

Dijalog Type of Follower za izbor aksijalnog ili obrtnog kretanja.

Dijalog Cam Design and Calculation sa opcijom Profile.
Dijalog Cam Design and Calculation sa opcijom Location.
Skup mogucih odnosa brzine i ubrzanja klizaca.

. Formiranje odnosa ugaonog polozaja bregaste ploce i pomeranja klizaca.

. Otvaranje opcija za proracun ¢vrstoce.

. Izvestaji o proracunu u dijalogu Cam Design and Calculation.

. Cuvanje i koris¢enje podataka nakon proraduna.

. Zavisnost pomeranja, brzine i ubrzanja klizac¢a od ugaonog polozaja bregaste ploce.
. Generisanje crteza bregastog mehanizma.

7=~ Kontrolna pitanja za Poglavlje 19:
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Elektronske graficke komunikacije.
Komunikacije posredstvom alata eTransmit.
Komande za komunikaciju eTransmit.
Postupci pakovanja fajlova.

Pregled formiranih fajlova.

Dijalog View Transmittal Report za pregled fajlova za eksport.
Kreiranje i objavljivanje WEB dokumenata.
Dijalog za kreiranje Web-a Publish to Web - Create Web Page.

Dijalog za kreiranje slike Publish to Web - Select Image Type.

. Dijalog za izbor uzornog fajla prikaza crteza Publish to Web - Select Template.
. Dijalog za selekciju crteZa Publish to Web - Select Drawings.

. Dijalog Publish to Web - Generate Images.

. Generisanje tehni¢kih dokumenata.

. Komande AutoCAD Mechanical-a za konfigurisanje plotera
. Postupak konfigurisanja plotera i Stampanje crteza.

. Dijalog Plot - Model sa osnovnim opcijama za izbor stampaca Printer/plotter i formata

crteza Paper size.



product Desi

Postovani,

Zadovoljstvo nam je da Vam predstavimo novu akciju kompanije Autodesk® u prodaji paketa softvera.
Tokom promotivnog perioda od 1.novembra 2011. do 13. januara 2012., nudimo promotivne popuste, u
odnosu na regularne preporuc¢ene maloprodajne cene Autodesk softvera.

Popusti koji ¢e biti dostupni u ovom periodu odnose se na sledece pakete namenjene projektovanju u
masinskoj industriji:

*  Popust na Product Design Suite 2012 i Factory Design Suite 2012 — do 20% popusta

* Upgrade sa AutoCAD i AutoCAD LT na Product Design Suite 2012 i Factory Design
Suite 2012 - 50% popust na cenu upgrade-a sa verzija 2009-2012

v'  Autodesk® Product Design Suite nudi najkvalitetnije alate za projektovanje i izradu tehnicke
dokumentacije pomocu kojih cete ostvariti konkurentan proizvod. Autodesk® Product Design Suite
2012 namenjen je projektantima i inZenjerima koji Zele da dopune funkcionalno 3D projektovanje u
masinskoj industriji sa moénim alatima za vizealizaciju proizvoda: IstraZite brzo konceptualni dizajn
projekta i napravite zadivljujuce ilustracije u digitalnom bloku za skiciranje. Kreirajte i pregledajte crteZe
koriste¢i kompletan skup alata za masinsko projektovanje. Kreirajte upecatljive slike, filmove i
interaktivne prezentacije

v'  Autodesk® Factory Design Suite 2012 omogucava projektantima opreme fabrickih postrojenja da
efikasnije projektuju, dokumentuju i razmenjuju podatke u DWG™ formatu sa drugim ucesnicima
izrade projekta. Koristite jedinstvenu funkcionalnost modula za raspored opreme (lay-out) u programu
AutoCAD® . Kreirajte raspored objekta pomocu podrske za analizu procesa. Napravite analizu protoka
materijala i delova. Program sadrZi veliku biblioteku standardne fabricke opreme. Procenite brojna
scenarija za moguca idejna resenja u ranoj fazi procesa projektovanja.

Izaberite paket koji ¢e vam pomo¢i u povecanju produktivnosti i primenite njegova sveobuhvatna reSenja sa
sjajnim dodatnim vrednostima i moguénostima.

Pogledajte kako najnovije verzije Autodesk paketa programa mogu da vam pomognu da se istaknete u odnosu
na konkurenciju i uvedu vas u digitalni svet u kome moZete da kreirate, vizuelizujete, simulirate, izradujete
dokumentaciju i upravljate projektima celovito.

Promotivni popust je dostupan kod prodavaca koji ucestvuju u ovoj kampanji.

"OSA - Racunarski inZenjering" doo

Takovska 45, 11000 Beograd, Srbija f

tel. +381 11 3290 362 /

fax. +381 11 3291 353 - )
Racunarski inZenjering

WWW.0Sa.rs
www.autodesk.osa.rs
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Ukoliko ste povezani na internet,
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i narucite knjigu.
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